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Typographic Conventions

Type Style Represents

Example Text Words or characters that
appear on the screen. These
include field names, screen
titles, pushbuttons as well as
menu names, paths and
options.

Cross-references to other
documentation

Example text Emphasized words or phrases
in body text, titles of graphics
and tables

EXAMPLE TEXT Names of elements in the
system. These include report
names, program names,
transaction codes, table
names, and individual key
words of a programming
language, when surrounded by
body text, for example,
SELECT and INCLUDE.

Example text Screen output. This includes
file and directory names and
their paths, messages, names
of variables and parameters,
source code as well as names
of installation, upgrade and
database tools.

Example text Exact user entry. These are
words or characters that you
enter in the system exactly as
they appear in the
documentation.

<Example
text>

Variable user entry. Pointed
brackets indicate that you
replace these words and
characters with appropriate
entries.

EXAMPLE TEXT Keys on the keyboard, for
example, function keys (such as
F2) or the ENTER key

Icons

Icon Meaning

Caution

Example

Note

Recommendation

Syntax
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SAP Front End Installation Guide
Purpose
This documentation describes how to install and distribute the SAP front-end software on
Windows platforms.
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Part I Introduction
Documentation in the SAP Service Marketplace
You can find this documentation at the following address:
http://service.sap.com/instguides

Preparatory Reading
You can find the Network Integration Guides at the following address:
http://service.sap.com/network

SAP Notes
For the latest information on:

•  Hardware requirements, see SAP Note 26417

•  Supported front-end platforms, see SAP Note 66971

•  Delivery, see SAP Note 166130

SAP GUIs
The SAP GUI Family consists of:

•  SAP GUI for HTML

•  SAP GUI for the Java environment (SAP GUI for Java)

•  SAP GUI for the Windows environment (SAP GUI for Windows)

SAP GUI for HTML is based on the Internet Transaction Server (ITS). The Internet
Transaction Server needs to be installed on the server side. On the desktop, a suitable
browser (for example, Internet Explorer 4.01 or higher) is sufficient. Since the SAP GUI for
HTML does not need SAP software to be deployed on the client, this GUI is not covered
here.

SAP GUI for Java is a generic SAP GUI that covers a variety of platforms. It has the same
look and feel as the windows version with the exception of the platform-specific window
decoration. The SAP GUI for Java was designed for use with the Workplace, but it can also
be used without the Workplace.

Installation of SAP GUI for Java is described in the documentation that can be found in the
folder GUI/DOC on Presentation CD2. The documentation can also be found at
ftp://ftp.sap.com/pub/sapgui/java/

SAP GUI for HTML and SAP GUI for Java do not have all the capabilities of SAP GUI for
Windows. For example, new dimension applications require the SAP GUI for Windows.

For more information about the SAP GUI Family, see http://service.sap.com/sapgui

Platforms
As of Release 4.x, controls are used in the SAP front end. Microsoft ActiveX controls are
used in the SAP GUI for the Windows environment which is used only by Windows 98,
Windows NT 4.0, Windows 2000, and Windows XP. The SAP GUI for the JAVA environment
is also available for these Windows platforms.

All other platforms use the SAP GUI for the JAVA environment where controls are
implemented by means of JAVABeans.

http://service.sap.com/sapgui
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Upgrading and Patching
The term “upgrade” is used to refer to the transition from one Release to another, for example
from 4.6C to 4.6D. The term “patch” refers to changes within a release to remove errors. In
an upgrade you should proceed exactly as for a new installation (upgrading SAP GUI for
Windows is an exception).

Installation of the SAP Online Documentation
You require access to the SAP online documentation from the front end. If you use SAP
Systems with Release 4.0x and older in your system environment, you must set up access
for the required type of online documentation. You can access both types of online
documentation at one front end.

Online Documentation from Release 4.0A
SAP delivers an HTML-based solution for online documentation. The installation of this online
documentation is described in the guide Installing the SAP Library. Use this guide when
planning a new installation or an SAP upgrade. It deals with all aspects you should take into
account when installing the online documentation on all R/3 platforms and all front-end
platforms.

Online Documentation before Release 4.0A
For information, see the platform specific chapters of this guide.
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Part II SAP GUI for the Windows
Environment
Platforms
The SAP GUI for Windows can be installed on:

•  Windows 98

•  Windows NT 4.0

•  Windows 2000

•  Windows XP

SAP Notes
SAP Note 456905 lists SAP Notes relevant to SAP GUI for Windows.

Benefits as of 6.20
The installation process has the following new features:

•  The new installation software has a new user interface with wizards to make the
installation process easier.

•  Services for local security handling are easy to configure.

•  Configuration of the installation can be started from the Windows Control Panel.

•  Updating the installation is easier. Installed components are updated without needing to
be selected.

•  The installation is faster and more stable. One reason for this is offline registration of
controls.

•  Components can be added or removed after the installation has been completed.

•  There is no need to reboot for Windows 2000 and XP. For Windows 98 and NT 4.0, a
reboot is only required if Microsoft files need to be updated. This would only occur at the
start of the installation process.

Deployment Scenarios for SAP GUI for Windows
SAP GUI for Windows should, in most cases, be installed from an installation server. This is
called server-based installation. In this method, the administrator sets up an installation
server from which the installation of the SAP front-end software on many different clients can
be achieved efficiently. The figure below shows a typical configuration and summarizes the
operating system requirements.
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Installation Server
Installation files
including
sapadmin.exe &
netsetup.exe.

OS: server version
of Windows NT,
2000, or XP

Administrator

Recommended OS:
Windows 2000

Client

OS: any supported
Windows version

Client

OS: any supported
Windows version

Client

OS: any supported
Windows version

netsetup.exe
sapadmin.exe

OS: Windows NT,
2000, or XP.

Distribution
Service (DS)

DS can reside on
the installation
server or on a
separate computer.

DS

Server-based installation is very flexible, and offers the following options for installing SAP
GUI for Windows:

•  without user interaction (unattended)

•  with user interaction (attended)

•  automatically when a user in the Workplace chooses an appropriate entry in the
Launchpad

The SAP GUI for Windows deployment scenarios are :

•  Server-based local installation. All the installation files are copied from the server to the
client during installation.

•  Server-based server-dependent installation. Most binary files reside on the server.

•  Installation in mySAP Workplace. This is like the server-based server-dependent
installation. The GUI is installed when required from within the Workplace.

•  CD-based local installation. This is mainly for testing purposes or for stand-alone
computers. The administrator takes the installation CD from PC to PC.

Server-Based Installation
We recommend using server-based installation when several workstations or more are
involved. The installation process is easy to do. Server-based installation is flexible and
makes maintenance easier, for example when patches are to be applied.

Which components to be installed, on which workstations, depends on the types of user.
Different types of user have different requirements. For example, an employee in the HR
department would require different components from a software developer.

The administrator groups various components together as packages relevant for certain
types of employee. The administrator can specify which package particular users receive or
else offer a variety of packages and allow the user to choose the most appropriate one.

The hard disk requirement on the installation server is approximately 380 MB.
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The three different types of server-based installation (local, server dependent, and server
dependent via mySAP Workplace) have different advantages and are described below in
more detail.

Server-Based Local Installation
With server-based local installation, the installation files are copied to the client. This has
several advantages:

•  Provides best performance and reliability (after installation, no fileserver has to be up).

•  Makes the client independent of the installation server.

•  Runs faster because files are not loaded from the network.

As administrator, you can configure your own installation packages with SAPAdmin on the
installation server or use the pre-configured packages provided by SAP.

You apply patches on the installation server and call SAPSetup on your client again to apply
the patch on the client. Installation may be via the command line. You can carry out
unattended installations and automatic patch deployment on the client. To do this you place
the appropriate command line in the logon script of the client. The logon script is a program
that is executed when you log on.

Server-Based Server-Dependent Installation
With server-based server-dependent installation, all the installation files, except System
DLLs, remain on the server. Therefore the footprint on a client is minimal. The installation is
also much faster.

Server-dependent installation dramatically reduces maintenance: if the logon script contains
the appropriate commands, patches need only be applied on the server for the clients to
benefit from them automatically.

A high performance LAN is desirable, as is load balancing and high availability of the
fileservers.

A disadvantage of this installation method is that greater network bandwidth is required
because everything has to be passed via the network.

You can use one of SAP’s pre-configured server-dependent installation packages or create
your own using SAPAdmin.

Server-Based Server-Dependent Installation via mySAP Workplace
This is like server-based server-dependent installation but there are no prerequisites for the
client except for Internet Explorer 4.01 or higher. In the Workplace, the Windows GUI can be
installed on demand. This means that when a transaction is selected that requires a Windows
GUI, one is automatically installed (if it has not already been installed). The administrator
needs to configure this function in the WnGUI service file on the ITS server.

Local Installation from CD
Local installation from CD is useful for installing the SAP GUI on single machines (for
example, laptops) that are not connected to a Local Area Network (LAN). It can also be
useful for test purposes.

Local installation from CD has disadvantages. No deployment scenarios are available. When
patches need to be applied, each workstation gets patched separately.
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1 Installing the Front-End Components
Prerequisites
You have used Note 26417 to check that all hardware and software requirements for the
front-end workstations have been met. If you do not have access to SAPNet, use the fax
request form included in the software package.

Remarks on Installation
The SAP GUI is downwards compatible. You can always use a later SAP GUI version with an
earlier or identical R/3 Release.

From Release 4.x, the SAP front end for 32-bit Windows platforms uses Microsoft controls
technology. All controls must be registered locally. As a result, the system database contains
an entry indicating where each control can be found. Since the system always registers the
latest controls, only the most recently installed version of a control is available at any time.

This means that a computer can contain only one version of the 4.x 32 bit GUI. During
installation, any GUI of 4.5A or later is automatically uninstalled. You can have a 3.x (16 or 32
bit) GUI on the same machine as a 4.x 32 bit GUI.

Installation

Server-Based Installation
The following describes a typical flow for server-based installation and maintenance.

1. Set up an installation server and, if necessary, the local security handling. See Setting Up
an Installation Server. [Page 14]

2. Define installation packages for different user groups. See Maintaining Installation
Packages [Page 16].

3. If  the local security handling has been set up, test it. You can do this by logging on to a
user PC with a user account without local administrator rights and running netsetup.exe.

4. Distribute the packages using the logon scripts of the user PCs. See Installing Packages
Using the Logon Script. [Page 21]

5. Maintain the installation by applying patches. See Patch Deployment. [Page 23]

6. Upgrade when a new front-end release becomes available. See Upgrading the Front End
[Page 22].

Local Installation from CD
See Local Installation from CD [Page 32].

Help and Reporting Problems
During the installation procedure, you can always use the online help. If you experience
problems, you should check the installation [Page 29] and consult the log files [Page 30]
before contacting support. When reporting problems, always send the log files as well.
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2 Distributing the Front-End Components
The Installation Server
Before you can distribute the front-end components, you must set up an installation server.
After installation, this server contains:

•  Installation programs

•  Configuration information (for example, for packages)

•  Service files ( for example, for local security handling)

•  The front-end components to be installed

For a detailed description on how to proceed, see Setting Up an Installation Server.

Installation Packages
After the installation server is set up, you can create installation packages that users can run
from the server. Users can install several packages, even if the packages share common
components.

Each installation package defines the components to be installed. Administrators may define
whether package installations are server-based or local. For a detailed description on how to
proceed, see Maintaining Installation Packages.

Server-based Packages
If there is a fast connection to the installation server that is not susceptible to downtime, we
recommend server-based installations. This way, as many files as possible are stored on the
server and executed from there. As a result, you save disk space and keep installation time
to a minimum.

Local Packages
If your network connection is slow, we do not recommend server-based packages, since the
number of accesses made to the server have a negative effect on performance. In this case,
you should install locally.

As a rule, we advise you to install locally whenever you are using many other front-end
components, like R/3 add-ons, besides the SAP GUI.

The Distribution Service and the Installation Service
Windows NT, Windows 2000, and Windows XP, have local security mechanisms. In these
systems, only users with local administrator rights have write access to parts of the system
database and the file system.

SAPSetup provides a convenient solution to this problem through the Distribution Service
(DS), which resides on the server, and the Installation Service (IS), which the DS installs on
the client. The IS starts a new instance of sapsetup.exe that runs with sufficient privileges.
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3 Planning Installation from Installation Server
Before installing, you should consider the following points:

•  Which computer do you want to set up as an installation server?

The computer you select for this purpose should be accessible for all users at any
time, even after the installation is complete. This is required for maintenance
purposes such as the distribution of patches. The network connection should allow
high throughput. You need 300-400 MB of free disk space. The installation server
should have a server version of Windows NT, Windows 2000, or Windows XP.

•  Which components are to be used by which user groups?

You can create special installation packages for different user groups, who can then
install only the components they actually need. Try to determine in advance which
components are needed and which packages you need to create. You can predefine
the destination folder for a package.

Hard Disk Clones
If the Windows NT, Windows 2000, or Windows XP operating systems were generated
through hard disk clones on the user PCs, make sure that the domain is correct. To do this,
take the computers out of the domain and then put them back in.
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4 Setting Up an Installation Server
Use
If the front-end software is to be installed on a large number of computers in a network, you
must set up an installation server first. When you do this, all files needed for installations from
this server are copied into a shared directory on one computer.

Prerequisites
You need local administrator rights under Windows NT,  Windows 2000, or Windows XP.

Procedure
1. Create a folder for the installation and share it. You need to grant read-permission for the

clients that will be using this installation server, and local administrator authorizations for
the account that will be used by the Distribution Service. For example, under Windows
2000:

a. Right-click the folder.

b. Choose Sharing...

c. Select Shared this folder

d. Choose Permissions

e. For the clients (Everyone), select Allow for Read, and deselect Allow for Change and
Full Control.
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f. Choose ADD, and add the name of the account to be used by the Distribution
Service.

g. For Full Control, Change, and Read, select Allow.

h. Choose OK.

2. In folder Gui\Windows\Win32\SETUP on the Presentation CD1, start admsetup.exe.

The wizard appears.

3. Choose Next.

A dialog box appears.

4. Enter the target folder to which the setup files are to be copied. This is the shared folder
that you specified in step 1.

5. Choose Install to start the installation process.

The installation process starts. All required files are copied to the installation server
folder. Due to the volume of data involved, this process takes some time. When the
installation process is finished, another wizard appears asking for two user accounts.
This configures the Distribution Service.

6. Enter the name and password of an administrator account that has local administrator
authorizations on all the clients to which the front-end software will be distributed. For
example, a domain administrator would satisfy these requirements.

7. Choose Next.

8. Enter the name and password of a domain user account and choose Finish.

This account only requires read access to the installation server. It becomes a
member of the local administrator group.
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5 Maintaining Installation Packages
After setting up an installation server, administrators can create installation packages for
installation by users. The administrator uses SAPAdmin for this purpose. SAPAdmin can be
found in the \SETUP folder on the installation server.

Permissions
If you do not want users to be able to install components (instead of predefined packages)
from the installation server, the administrator must set up the permissions. The administrator
needs to do this from a computer that has Windows 2000. The installation server must be
running Windows NT/2000 or later. Server access authorization is not available on Windows
9x/Me clients.

Procedure
1. On the installation server, start SAPAdmin.

2. Choose Server → Permissions...

3. Deselect Install Components from Server.

4. Choose OK.
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5.1 Creating a New Installation Package
Procedure
1. On the installation server, start SAPAdmin.

2. Choose File → New Package.

The Package Wizard starts.

3. Enter a name for the package, then choose Next.

4. Select the components to be included in the package, then choose Next.

When you select a group or component, a short description with the disk space
required is displayed on the right. A checked box is white if all the components
underneath have been selected, but is gray if only some have been selected. If you
select a component that requires other components, these are automatically selected
as well.

5. Select the type of installation for the package, then choose Finish.

You can choose between local installation and server-dependent installation. For
more information, see Server-Based Installation.
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5.2 Modifying Installation Packages
Procedure
1. On the installation server, start SAPAdmin.

2. Select a package, and choose Edit → Package Content.

The Package Wizard starts.

3. Select or deselect components.

When you select a group or component, a short description with the disk space
required is displayed on the right. A checked box is white if all the components
underneath have been selected, but is gray if only some have been selected. If you
select a component that requires other components, these are automatically selected
as well.

4. Choose Finish.

5. Choose File → Save.
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5.3 Creating Files for use with SMS, Tivoli, and Others
Use
SAPSetup can be integrated with the Microsoft Systems Management Server (SMS), Tiviloi,
and others, which means that you can start installation packages as SMS jobs. For this
purpose, you can use SAPAdmin to generate a .PDF and an .SMS files for each installation
package.

Procedure
1. Select a package, and choose File → Export → Package Definition File...

2. Enter a folder and name for the files, then choose Finish.
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6 Installing from a Server
Prerequisites
An installation server has been set up.

Either the appropriate authorizations are available or the Distribution Service has been
configured.

Procedure
1. Map the shared directory, containing the installation files on the installation server, to a

local drive.

2. Start netsetup.exe from the root folder of the mapped drive.

If a user is authorized to install several packages, a list of these packages is
displayed.

3. Select the components or packages to be installed, and choose Install.
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6.1 Installing Packages Using the Logon Script
Use
Since the front-end software is normally installed on a large number of computers, SAPSetup
allows you to automate this task as well as take advantage of SMS integration.

By inserting a command line into the logon scripts of the computers on which the front-end
software is to be installed, you can start a package installation each time the user logs on.

Procedure
Insert the following command line (both the path and either the package name or unique
package identifier must be used):
\\<server>\<shared folder>\setup\sapsetup.exe /p:“<package name>“

or
\\<server>\<shared folder>\setup\sapsetup.exe /p:“<unique package
identifier>“

The unique package identifier is automatically generated when you create a
package. It cannot be altered. Run SAPAdmin and select the package to see its
unique package identifier. It is better to use the unique package identifier rather
than the name, because the name need not be unique and can be changed.
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7 Upgrading the Front End
Use
Upgrading is the same as doing a new installation.

The installation software automatically uninstalls a preexisting GUI of release 4.5A or later.
GUIs of earlier releases are unaffected.

You should run sapsweep.exe to remove older 4.X GUIs.
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8 Patch Deployment
Server-Based Patch Deployment

Procedure
1. Download the patch by FTP from SapServ, or from the SAP Service Marketplace at

http:service.sap.com/ocs-download

2. Apply the patch to the installation server. See Applying Patches to Installation Servers.

3. Distribute the patch to the clients. See Distributing Patches to Clients.

Patch Application on Standalone Computers
In this case, patches are applied to a PC or notebook without an installation server. The GUI
must have been installed using a CD. See Applying Patches to Standalone Clients.
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8.1 Applying Patches to Installation Servers
Use
Apply the patches to the server and, if used, update the Distribution Service. The patch level
of the server can be displayed in SAPAdmin by choosing View → Server Monitor.

Prerequisites
You have downloaded the latest patch files from your regional SapServ FTP server.

Procedure
1. Start sapadmin.exe.

2. Choose Tools → Apply Patch...

3. Choose Browse to select the patch, then confirm your selection with Open.

A list of files appears.

4. Choose Install.
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5. If the Distribution Service (DS) is used, update it. Either start SAPAdmin and configure
the DS (choose Server → Configure Services...), or

a. Stop the service. You can use Services in the Windows Control Panel to do this.

b. Replace all .exe and .dll files of the DS, in folder the %windir%\SAPWksta (usually
c:\winnt\sapwksta) of the DS server, with the newer files from the Setup folder
of the installation server.

c. Restart the service. You can use Services in the Windows Control Panel to do this.
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8.2 Distributing Patches to Clients
Prerequisites
The installation server has had the latest patch applied.

Procedure

Manual Application of Patches

Alternative 1.
1. In the Windows Control Panel on the client, Choose Add/Remove Programs.

A list of installed applications appears.

2. Choose SAP Front End from the list, and choose Change (on Windows 98 choose
Add/Remove).

3. Choose Change.

4. Select Synchronize all SAP Front-End components with the installation source.

5. Choose Finish.

This updates everything that is installed.

Alternative 2.
1. In the Windows Control Panel on the client, Choose Add/Remove Programs.

A list of installed applications appears.



 SAP Front End Installation Guide

July 2002 27

2. Choose SAP Front End from the list, and choose Change (on Windows 98 choose
Add/Remove).

3. Select Add or remove one or more SAP Front-End components, then choose Finish

4. The configuration wizard appears.

The Configuration Wizard starts. Components that are obsolete are grayed out.

5. Select the grayed-out components.

6. Choose Next.

7. Choose Finish.

Automatic Application of Patches
1. Add the following command line to the logon script of the client:

sapsetup /update
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8.3 Applying Patches to Standalone Clients
Prerequisites
You have local administrator rights under Windows NT, Windows 2000, or Windows XP.

Procedure

Using the Control Panel
1. Select ADD/Remove Programs from the Windows Control Panel.

A list of installed applications appears.

2. Choose SAP Front End from the list, and choose Change (on Windows 98 choose
Add/Remove).

The configuration wizard appears.

3. Select Apply a SAP Front-End patch (for stand-alone computers, e.g. laptops), then
choose Finish.

4. Select the patch that you want to apply.

5. Choose Finish.

Using the Command Line

With user interaction
1. From the command line, run sapsetup /patch

2. Choose the patch and then choose Open.

3. Choose Finish.

Without user interaction
From the command line, run sapsetup /patch:"<path>\<patch>.exe"
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9 Checking the Installation
Use
This can be used for server-based installations or for standalone installations. You can save
the results of the check in a file which can be used by SAP support.

Procedure
Call sapsetup.exe /check
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9.1 Viewing the Log
Use
You can check the installation by viewing the log file sapsetup.log. The log file can be
found in:

•  C:\WINDOWS\ under Windows 98 or Windows XP

•  C:\WINNT\ under Windows NT 4.0 or Windows 2000

The most recent log has no number. The older logs are numbered. The higher the number,
the older the log. Each time new log is generated, each of the log numbers is incremented by
1.

Procedure
Run saplogvw.exe from the server, to start the SAPSetup Log Viewer.

Enter the path and filename of the log file.

Choose Finish.

The log file is displayed. Errors are colored red. Warnings are colored blue.
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10 Uninstalling the SAP Front End
Procedure
1. In the Windows Control Panel, choose Add/Remove Programs

2. Select SAP Front End.

3. Choose Remove (Under Windows 9.X choose Add/Remove).

4. Select Uninstall all SAP Front-End Components.

5. Choose Finish.

If something is running that needs to be shut down, a dialog box appears.

Result
The SAP Front End is uninstalled and a log file generated.
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11 Local Installation from CD
Use
To install front-end software components on a single computer. You can install directly from
CD without setting up a front-end server.

Prerequisites
You need local administrator rights under Windows NT,  Windows 2000, or Windows XP.

Procedure

Installing the SAP Front End
1. In folder Gui\Windows\Win32\SETUP on the Presentation CD1, start setup.exe.

The setup wizard appears.

2. Choose Next.

3. Specify the target folder for the program files. The default is C:\Program
Files\SAP\FrontEnd

4. Choose Next.

The setup wizard displays a hierarchical tree containing the components, and groups
of components, you can select.

5. Select the components you want to install. When you select a group or component, a
short description with the disk space required is displayed on the right. A checked box is
white if all the components underneath have been selected, but is gray if only some have
been selected.

6. Choose Next.

7. Choose Install.

The installation starts. If a restart is required, a dialog will appear. In this case choose
OK. The reboot would only occur at the start of the installation process.

Changing the Configuration
1. Select ADD/Remove Programs from the Windows Control Panel.

A list of installed applications appears.

2. Choose SAP Front End from the list, and choose Change (on Windows 98 choose
Add/Remove).

The configuration wizard appears.

3. Select Add or remove one or more SAP Front-End components, then choose Finish.

4. Select or deselect the components that you want to add or remove respectively.

5. Choose Install.

Uninstalling the SAP Front End
1. Select ADD/Remove Programs from the Windows Control Panel.

A list of installed applications appears.

2. Choose SAP Front End from the list, and choose Change (on Windows 98 choose
Add/Remove).
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3. Select Uninstall and Finish.

4. Confirm your decision in the dialog box that appears.
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12 Command Line Parameters
You can call SAPsetup.exe with the parameters listed in the table below.

SAPSetup Parameter Description

/check[:"<file name>"] [/silent] Checks all the installed components.

/config Starts the configuration wizard for adding or
removing components and packages.

/p:["<package name>"] [/uninstall] [/silent] Displays the wizard for choosing packages.

/patch Only for a local installation from CD. Starts
the wizard for selecting and applying a patch.

/server[:"\\<installation share folder>"]
[/update]

Applies the delta for a new compilation.

/silent Displays no user interface – not even
progress.

/uninstall Uninstalls all components.

/update Updates all components.

You can call SAPAdmin.exe with the parameters listed in the table below.

SAPAdmin Parameter Description

/config Starts the configuration or installation of the
DS.

/patch[:"<gui patch>"] [/silent] Starts the wizard for selecting and applying a
patch.

/server:"\\<Server>\<Share>" Configures the specified installation server.

By default, SAPAdmin configures the installation server from which it was started. The /server
switch is also useful for applying setup patches that contain SAPAdmin or other setup
binaries. SAPAdmin cannot be replaced on the installation server from which it is running. To
solve this without requiring to restart the server, you can run SAPAdmin from a different
location, for example the Presentation CD, and apply a setup patch on your installation server
by using this commandline :
<CD Drive>:\GUI\Windows\Win32\setup\sapadmin.exe
/server:"\\<Server>\<Share>"
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13 Component List
The component list describes the features and functions of the selectable components, and
the prerequisites for using them. The components are grouped under component groups.

List of Component Groups
Component Groups

Group Description

SAP GUI SAP GUI and related components.

R/3 Add-On Front-end add-on for SAP R/3 Enterprise. This package
contains application extensions needed for some R/3
transactions

General Add-On Front-end add-on that can be used to extend
functionality of SAP systems and that are not restricted
to one SAP Component (R/3, BW, APO, CRM, SEM,
KW, EP, ...)

Development Tools Collection of Tools for Development.

Legacy Components Components for use with older SAP releases (R/3 4.6
and lower) or old Office products (Excel 95, ...). These
components will only be needed if you intend to use this
version of SAP GUI for Windows with your old SAP
installations.

APO Add-On Front-end add-on for SAP Advanced Planning and
Optimization (APO)

BW Add-On Front-end add-on for SAP Business Information
Warehouse (BW).

CRM Add-On Front-end add-on for SAP Customer Relationship
Management (CRM).

KW Add-On Front-end add-on for SAP's Knowledge Management
solution that includes all SAP training courses and all
SAP documentation.

SEM Add-On Front-end add-on for SAP Strategic Enterprise
Management (SEM).

List of Available Components
SAP GUI

Component Description

SAP GUI with SAPLogon SAP graphical front end with starter application
SAPLogon. The user can display and modify connection
information for SAP systems using SAPLogon.

SAP GUI with SAP Logon-Pad SAP graphical front end with starter application
SAPLogon-Pad. The user can only display preconfigured
connection information, for SAP systems, provided by
the installation administrator.

SAP GUI Scripting SAP GUI Scripting Interface.
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GUI XT GUI Extensions for client side customizing of SAP
screens.

Shortcut to SAPlpd Routing program for print output on Windows PCs.
SAPlpd is addressed via a network connection or locally
via SAP GUI. If used via network connection, PC must
have a fixed IP address, and SAPlpd must be started
manually before printing.

R/3 Add-On

Component Description

EC-CS: Remote Data Entry Module EC: Data input and validation of reported
financial data without a connection to a R/3 System.
Requires MS Access 97.

FI-LC: Remote Data Entry Module FI: Data input and validation of reported financial
data without a connection to a R/3 System. Requires MS
Access 95 or 97.

Interactive Excel Module FI or EC: Add-on to MS Excel for creating
reports in Excel using data from FI-LC or EC-CS
consolidation. Excel sheets can be filled with data from
R/3 or the Remote Data Entry tools for FI-LC and EC-
CS. It can be used for data entry into the FI-LC or EC-CS
Remote Data Entry tool. Requires MS Excel 97.

CA-CAD Interface Module CA: CAD interface of the SAP System.

EC-EIS: MS Word Link Module EC /Executive Information System: Transfer of
report data to Microsoft Word. Requires MS Word 95, 97
or 2000.

PD: MS Excel Link Module PT/ Shift Planning: Allows to display the SAP
duty roster data with Microsoft Excel. Requires MS Excel
5, 95, 97 or 2000.

PS: Export Interfaces Module PS: Export of project data in the formats
GRANEDA, MS Access and MPX. Requires Graneda,
MS Project 4 or any other program that can read MS
Access 7 data.

Windows Word Processor
Integration

Module EH&S /Safety: Creation of templates and reports
for the R/3 environment data system. Requires MS Word
95, 97 or 2000.

General Add-On

Component Description

SAP Console SAP Console is a framework in which several software
components work together enabling users to access and
execute R/3 transactions from character-based devices.
The three main components involved are "SAP
Console", "SAP Console Administrator" and "SAP
Console I/O Engine". For Windows NT or Windows 2000
only!
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SAPphone Call Status Control The SAPphone Call Status Control allows to raise events
to inform the R/3 SAPphone softphone user interface
about telephony call state changes. The control itself has
no user interface. It must not be reused by other
components beside SAPphone. For Windows NT or
Windows 2000 only!

SAPphone Server Tool to connect the R/3 System to telephone systems
and call centers. For Windows NT or Windows 2000
only!

Microsoft Outlook Integration Integrates SAPoffice and WebFlow with MS Outlook,
allowing the Outlook client to view, manipulate, and
navigate SAPoffice folders and messages and WebFlow
work items. In addition this software enables the
SAPoffice Calendar to synchronize with the MS Outlook
calendar in both directions. Requires Microsoft Outlook
98 or greater.

Graphical Distribution Network Display and maintenance of a distribution network inside
a corporation.

Development Tools

Component Description

Graph Layout Toolkit ABAP Development Workbench extension that offers
graph editing and automatic layout.

Graphical Screen Painter Graphical editor for the ABAP Development Workbench
ScreenPainter.

RFC SDK Libraries RFC Libraries for software developers. Includes the
DCOM Connector and the DCOM Object Builder. DCOM
Object Builder requires Visual C++ 5.0 or higher and
OLEDB SDK. On Windows 95, 98 and NT4 a system
upgrade using "mdac_typ.exe" by Microsoft is required.

SAPforms SDK for programming SAP Business Workflow with
Visual Basic forms, Microsoft Outlook forms, Lotus Notes
forms, or Lotus Domino.

SAPforms (Runtime) Contains the functions needed to start workflows and
process SAP Business Workflow work items using Visual
Basic forms, Microsoft Outlook forms, or Lotus Notes
forms.

SAPforms (Design-time) Contains the functions to enable Visual Basic forms,
Microsoft Outlook forms, and Lotus Notes forms to start
workflows and process SAP Business Workflow work
items. SAPforms (runtime) are included.

SAPforms (Lotus Notes Server) Contains the functions needed on a Lotus Domino server
to develop and maintain Lotus Notes forms to start
workflows and process  SAP Business Workflow work
items. SAPforms (design time) are included.

Legacy Components

Component Description
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XXL List Viewer Export of tabular data of R/3 3.x, 4.0, 4.5 to the PC and
display in Microsoft Excel. Requires MS Excel 95, 97 or
2000.

Lotus Connections Export of tabular data of R/3 3.x, 4.0, 4.5 to the PC and
display in the Lotus SmartSuite. Requires Lotus 1-2-3,
WordPro, Approach or Notes.

Report Writer: MS Excel Link Import filter of R/3 3.x, 4.0, 4.5 for MS Excel: converts a
file exported by Report Writer in Excel format (RPW
format) into an Excel spreadsheet. Works with Excel 95,
97 or 2000.

MS Word Link via RFC Installation of Word connection for SAP R/3 3.x, 4.0A
and 4.0B. Requires MS Word 6, 95, 97 or 2000.

APO Add-On

Component Description

APO Front End Front-end add-on for Advanced Planing and
Optimization (APO)

BW Add-On

Component Description

BW Add-on Business Information Warehouse front-end components.

Extension for ArcView ArcView Extension for Geo Coding.

Note: Extension for ArcView does not exist in BW3.0B
which comes with 6.20 Compilation 2.

OLE DB for OLAP Provider Client components of OLE DB for OLAP Provider.

CRM Add-On

Component Description

CRM

KW Add-On

Component Description

Knowledge Workbench Authoring Tool to easily maintain SAP documentation
and SAP training. Requires Microsoft Internet Explorer 5.

KW Online Editing Knowledge Warehouse Editing within SAPGUI. Requires
Microsoft Internet Explorer 5.

KW Translator Knowledge Warehouse Translator: Translation tool to
process translation packages offline. Requires Microsoft
Internet Explorer 5.

PAW Author Performance Assessment Workbench Author: Authoring
Tool to easily maintain test items, performance units,
performance tests and surveys. Contains "Knowledge
Workbench" and "KW Translator". Requires Microsoft
Internet Explorer 5.
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SAP Show Viewing Tool to display training courses offline, e.g. for
classroom training.

SEM Add-On

Component Description

Balanced Scorecard Balanced Scorecard Presentation.

Graphical Assignment Graphical Assignment Tool.

Management Cockpit Management Cockpit Presentation. Requires System
Upgrade using "mdac_typ.exe" by Microsoft on Windows
95, 98 and NT4.

Sales Planning Sales planning Add-In to MS Excel. Requires MS Office
97 or MS Office 2000. You can use this Add-In to extend
your local MS Excel to enable Sales Planning within
Excel environment as part of Customer Relationship
Analytics. Requires Microsoft Excel 97 or 2000.
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14 Supplementary Notes
Microsoft MDAC
MDAC is a program used to upgrade Microsoft systems.

The following components require you to upgrade your system using mdac_typ.exe,
version 2.5 or later:

•  RFC SDK Libraries

•  Management Cockpit

The Microsoft Component Checker Tool allows you to check which version of MDAC is
installed on the PC.

If you have selected a component that requires Microsoft’s mdac_typ.exe, and you have an
English-language operating system, the installation automatically executes
\system\mdac\en\mdac_typ.exe

If you have a Japanese-language system, the installation automatically executes
\system\mdac\ja\mdac_typ.exe

There are several language-specific (or localized) versions available from
http://www.microsoft.com/data/download.htm

If you have a localized installation (other than Japanese), the installation automatically
executes system\mdac\local\mdac_typ.exe, if the non-English version exists there.
Otherwise, the installation automatically executes \system\mdac\en\mdac_typ.exe

For more information on mdac_typ.exe, see Microsoft’s home page on the Internet.

ADSI Setup
If you use the Lightweight Directory Access Protocol (LDAP), you nevertheless need the
ADSI Setup (Active Directory Services Interface). There are several language-specific (or
localized) versions of ADSI Setup available from Microsoft. However, we deliver only the
English version on the CD. The English files are in the directory ..\system\ads\en:

•  ads.exe (for Windows NT 4.0, Windows 2000, and Windows XP)

•  ads98.exe (for Window 98)

To enable this version, use:
setup.exe /p:"$ms adsi"

You can find other language versions of ADSI Setup at the following URLs:

For Windows NT 4.0, Windows 2000, and Windows XP:

http://www.microsoft.com/NTWorkstation/downloads/Other/ADSI25.asp

For Windows 98:

http://www.microsoft.com/Windows95/downloads/contents/WUOther/ADSI25/Default.asp

The names of the original ADSI Setup files from Microsoft are for all languages:

•  adsx86NT.exe (for Windows NT 4.0, Windows 2000, and Windows XP)

•  ads98.exe (for Windows 98)

During the installation process of the files specified above dialog boxes appear which means
that the installation process is not "silent".

To skip these dialog boxes, proceed as described in the file ..\system\ads\readme.txt.
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If you prefer a specific language version, you can replace the files on your GUI server with
the files for the corresponding language. The following prerequisites must be met:

•  The files must have the following names:

− ads.exe

− ads98.exe

•  The non-English files must reside in the directory ..\system\ads\local to be able to be
called during the installation process.
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